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PREVENT A
DATA DISASTER  
BEFORE IT OCCURS
WITH A SECURITY RISK ASSESSMENT 
FROM TECHCENTRAL 

A data loss or breach can have staggering consequences. Legal 

fees, restitution, fines and negative media exposure may destroy 

your practice.  Take the first step in securing your protected health 

information (PHI) and let our data experts conduct a HIPAA-

mandated Security Risk Assessment (SRA) to evaluate your PHI 

inventory, security policies and safeguards. Trust the tech experts at 

Henry Schein TechCentral to protect your practice and its data.

www.HSTechCentral.com/ProtectYourPractice 
Call us at: 877.483.0382, Option 1
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LESLIE GARABEDIAN  |  OFFICE MANAGER

Dentrix Mastery Tracks

SPOTLiGHT

Where do you work?
Belmont Dental Associates in Haledon, New Jersey        

What is your title? 
Office Manager

What are some of the duties you’re responsible for in 
your practice? 
I’m in charge of overseeing day to day operations, monitoring 

policies in the office, presenting and closing treatment plans, 

setting up financial arrangements, practice marketing, employee 

hiring and training, collections and account receivables, payroll, 

maintaining relationships with local business and municipal 

government, and instituting and maintaining the therapy dog 

program in our office.

How long have you worked with Dentrix? 
3 years

Which certificates have you earned?
Dentrix Clinical Specialist, Dentrix Front Office Specialist,  

Dentrix Financial Specialist, Dentrix Practice Analysis Specialist

What got you interested in Dentrix Mastery Tracks?
I liked the idea of taking the tests myself to be able to review 

my current skills, including my strengths and my weaknesses. 

From an office manager standpoint, I think the tests are great 

to give to the staff to see where their weaknesses are. It gives 

me the ability to help and train them to improve. I also think it’s 

valuable from a hiring standpoint to see how knowledgeable 

potential applicants are.  

How has participating in Mastery Tracks helped you use 
Dentrix?
It gave me the ability to pinpoint areas where I need to improve. 

I also learned a few things I wasn’t aware of...like how to chart 

supernumerary teeth! If I came across something I didn’t know, 

I was forced to research it, which in turn helped me learn 

additional Dentrix functions.   

How has becoming a Dentrix specialist improved your 
career? 
Being a Dentrix specialist is a way to prove my knowledge with 

the Dentrix software as well as my knowledge in the dental 

field. It shows that I have taken the time and effort to educate 

myself to learn and hone my skills as a dental office manager. 

Being more knowledgeable in Dentrix has helped increase office 

efficiency and allows us to run more smoothly on a daily basis.  

What is your favorite Dentrix tip or trick?
There are a lot of Dentrix tips/tricks that I use and love, but two 

of my favorites are using the Verify Billing Statements to Send 

option and using procedure buttons when treatment planning.

Dentrix Mastery Tracks™ allows dental professionals 

to test how well they understand and can use Dentrix. 

Read on to find out about Leslie Garabedian, an office 

manager who has completed all eight Mastery Tracks 

tests and earned all four specialist certificates.

Is your team ready for your success? Visit Dentrix.com/Mastery and start using Dentrix Mastery 

Tracks to give your team the tools they need to measure and improve their Dentrix skills.



4 | www.Dentrix.com/Magazine

Dentrix Attachments

Payor iD Payor Name

86098  AmeriHealth DC Medicaid - Avesis

86098  AmeriHealth MI MMP (Medicare/ Medicaid) Avesis

62308  Caterpillar (A Cigna Plan)

36215  Central States Fund

36215  Central States Health & Welfare Funds

36215  Central States SE & SW Areas H & W Fund

62308  Compass Group (A Cigna Plan)

62308  Cracker Barrel Old Country Store (A Cigna Plan)

62308  Delphi (A Cigna Plan)

62308  Deluxe Corp (A Cigna Plan)

46278  DHW FL Medicaid Adults

46278  DHW FL Medicaid Children

46278  DHW FL Medicaid Long Term Care (LTC)

46278  DHW Medicare Advantage

62308  Federal Reserve (A Cigna Plan)

62308  FedEx (A Cigna Plan)

62308  Govt. District of Columbia (A Cigna Plan)

62308  Kellogg (A Cigna Plan)

62308  Lacera (A Cigna Plan)

62308  Lowes (A Cigna Plan)

62308  McKinsey (A Cigna Plan)

CX014  Medicaid VA Smiles for Children Over 21

62308  Phillip Morris/ Altria (A Cigna Plan)

62308  Shelby Schools (Memphis City Schools)

62308  Shell Oil (A Cigna Plan)

62308  St Gobain (A Cigna Plan)

62308  St of CT (A Cigna Plan)

62308  Sun Trust (A Cigna Plan)

36215  Teamcare

62308  Wyndam (A Cigna Plan)

Dentrix eClaims 

Payer iD Payer Name

39640  A & D Charitable Foundation Inc. (dba 

GreatLake PACE)

53589  Arizona Blue Cross Blue Shield

16180  Aspen

99660  Central Valley Medical Services (dba Fresno PACE)

66698  Comprehensive Senior Care Corp (dba Centra Care)

8754  Eddy Senior Care

CBFLF  Florida Blue FEP

59143  Harrington Health Colonial Dental

71498  LifeCircles PACE

AFSOH  Ohio AFSCME Care Plan

70454  PACE CNY

96400  San Diego PACE

64009  Valir Pace

48123  Via Christi HOPE

Dentrix insurance Manager

Payer iD Payer Name

CKVA1  DentaQuest Government Plans (Medicaid of 

Virginia)

47171  Kansas City Blue Cross Blue Shield of Kansas City MO

Dentrix eEOBs

Payer iD Payer Name

CBUTF  Blue Cross Blue Shield of Utah (FEP)

CBUT1  Blue Cross Blue Shield of Utah (UHIN)

CX010  Health Partner of Minnesota - Medicaid

View the entire list of electronic payor connections using the 

Payor Search Tool at www.dentrix.com/products/eservices/

eclaims/payor-search.

Appointment attendance is critical to the health of your 

patients and the success of your practice.  Regular hygiene 

and preventative care leads to better overall health, but 

you can’t treat patients who don’t attend their scheduled 

appointments. New eCentral Smart Messaging helps you solve 

this problem in three ways.  

First, the new Smart Messaging feature ensures that Dentrix 

and eCentral sync in real time so that your reminders will 

always be accurate. Patients get reminders for appointments 

that have been updated and moved to a different day or time, 

giving you peace-of-mind that your reminders will always 

match your Dentrix Appointment Book.

Second, the new Smart Messaging feature helps you avoid the 

problem of over-communication: bombarding the patient with 

so many messages they build a negative impression. eCentral 

Smart Messaging allows you to set a hierarchy for email, text, 

and postcard. This means that eCentral will look through all of 

the patient contact information and deliver a single reminder 

to the patient based on a hierarchy you define.

The third problem that Smart Messaging solves is incomplete 

patient contact information.  On average, nearly two-thirds 

of your patients will not have a complete set of contact 

information (mobile number, email, and mailing address). 

Looking through the Family File and deciding how to contact 

each patient individually is not the best use of your time. 

Smart Messaging will look through all of the patient contact 

information and deliver a single reminder to the patient based 

on the contact information you have on file.

Smart Messaging is available now. For more information or to 

order visit dentrix.com/promotions/smartmessages.

 eCentral Smart Messaging

 Announcing New Insurance Payor Connections
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dentrix.com/products/eservices/eclaims/payor-search


“Productivity is up 25%, 
and I attribute it, in part,
to the seamless integration  
of new technology into  
our practice. 
And our patients 
and staff love it!!” 
Michael Corson, DDS
Denver, CO

1-800-890-8153
www.henryscheindental.com

Henry Schein has the solutions you need  
to connect your practice technologies,  

increase work flow, and enhance efficiency. 

Rely on us to help you determine  
the most appropriate products and  

technologies to advance your practice 
and provide quality patient care.

3D CONE BEAM IMAGING   

CAD/CAM TECHNOLOGY   

COMPUTER HARDWARE   

DENTAL LAB INTEGRATION  

DIGITAL IMPRESSIONS   

DIGITAL PANORAMIC X-RAYS  

DIGITAL SENSORS  

INTRAORAL CAMERAS  

 PRACTICE MANAGEMENT SOFTWARE

HSDE-Dr-Corson- 8.5x10.75-Ad.indd   1 7/20/15   12:42 PM
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Share your input and help shape the 
future of Dentrix. 

It’s been almost two years since I became the product 

manager for Dentrix. In my first Dentrix Magazine article 

in the spring of 2014, I discussed the changing dental 

landscape and the need to work more closely together to 

chart a course for the future. I am pleased with the number 

of people who have participated over the last two years in 

helping to shape the future of Dentrix. I want to take this 

opportunity to remind you of existing methods to share your 

ideas and enhancements with us and a new method that we 

are introducing this year.

In 2014, we instituted the Dentrix Advisory Committee. 

This group of approximately 200 people, including IT 

professionals, dentists, office managers, hygienists, 

assistants, scheduling coordinators, billing coordinators,  

and more, have participated in focus groups, surveys, 

product demonstrations, and other activities to help us 

understand how we can continue to increase the value of 

Dentrix for all of our customers. This group continues to 

play a valuable role as we move forward with Dentrix. If you 

are interested in participating on the committee, please 

email me at brad.royer@henryschein.com.

In addition to the committee, we constantly review the 

myvoice.dentrix.com site, which currently has over 2,061 

suggestions and over 10,400 unique supporters. In Dentrix 

G6, we made this website even easier to access by adding 

the “Enhancement Request” option to the Help menu in 

all Dentrix modules. No matter where you are in Dentrix, 

it’s easy to let us know how we can improve your Dentrix 

experience. In addition, we have started to update the status 

of items as we research, plan, and develop future releases. 

We hope to increase transparency so you know what we 

are working on and we can continue to receive feedback 

during the development process. If you have not yet had a 

chance to add, review, or vote on an idea, I would strongly 

encourage you to visit the site.

I am also happy to report that in addition to these methods, 

we are adding another way for you to share feedback with 

us this year. At our Business of Dentistry Conference, which 

is being held in Orlando, Florida from October 7-10, we are 

holding eight focus group sessions for users to come and 

meet directly with me.  The topics we will cover include 

support, reports, front office, and chairside enhancements. I 

would love to see you at this event! Moreover, I look forward 

to the opportunity to discuss how we can continue to make 

Dentrix meet your changing needs.

I know that as we work together, we can improve efficiencies, 

lower costs, enhance clinical decision-making, and increase 

capacity for dental professionals using Dentrix. Thank you 

for all of your ideas and for your dedication to Dentrix! I can’t 

wait to see you at our Business of Dentistry Conference  

focus groups.  
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Three Ways You Can Help Us 
Improve Dentrix

BRAD ROYER
Dentrix Product Manager

www.myvoice.com
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Say hello to Dentrix G6! Find out what’s new and 
how it can streamline operations. Features include: 
 • Split payments by family member

 • Assign correct providers for completed procedures in  
  the Appointment Book

 • Unify your business and patient contacts and create  
  custom patient lists

 • Add more detail to patient medical alerts

Note: CE credits are not offered as part of the Insight Seminar training. For advanced, hands-on training using a computer we recommend you attend a workshop.  
Visit www.Dentrix.com/Workshops. 

Go beyond the basic features of Dentrix and 
discover better ways to:
 • Collect and manage accurate patient information

 • Improve and simplify schedule management

 • Streamline patient payments and track  
  practice profitability

 • Keep your database up to date and properly   
  backed up

Save time. Boost profits. In just half 
a day, you can begin to transform 
your practice by harnessing the full 
power of Dentrix.

$ ONLY

49Space Is Limited. Register Today!
Visit www.Dentrix.com/InsightSeminar or call 866.367.2711
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Updating Secondary insurance   

Since insurance coverage is not 

retroactive, Dentrix tracks what 

secondary insurance information 

was assigned to the patient 

when a primary insurance claim was created. 

Dentrix assumes that if the patient did not 

have secondary insurance assigned (or had 

a difference in coverage) when the primary 

insurance claim was created, any new secondary 

insurance information does not apply to that 

claim.  The Update Secondary Insurance option 

allows you to override the default if a mistake in 

assignment has been made. 

To update secondary insurance information:

1. Verify the secondary insurance information 

in the Family File is correct.

2. From the Ledger, double-click the primary 

insurance claim. The Primary Dental 

Insurance Claim window opens.

3. Double-click the Subscriber Information 

block. The Patient/Insurance Information 

dialog box appears.

4. Check the Update Secondary Insurance 

box, and then click OK.

The Dentrix Mastery Tracks™ program helps you 

assess and improve your Dentrix skills. Find 

tips that correspond with your job and use 

them to prepare for a test or just enhance your 

skills. Visit www.Dentrix.com/Mastery to learn 

more about Dentrix Mastery Tracks.

Tips
&Tricks

Save Time in the Batch Processor 

Did you know that you can preview any report in the 

Batch Processor by double-clicking it? This feature, 

available in Dentrix G5.2 or later, saves you from 

having to first select the report and then click the 

Preview button.  It’s a small thing that can save you many cursor 

movements over the course of a day! 

Financial Practice Analysis ClinicalFront Office
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Sorting and Filtering Progress Notes 

If you’ve ever had to look through a patient’s progress notes in the Chart to find information about a specific 

procedure or find treatment during a certain time period, then you know what a daunting task this can be for a 

patient who has had a lot of work posted. 

Here are a few different methods you can use to sort progress notes and change how the information is 

displayed, making it easier to find the information you need. 

1. Sorting progress notes 

by column - Click the 

column headings to 

arrange the information 

chronologically, 

numerically, or 

alphabetically (depending 

on the column you select). 

2. Use status buttons to 

narrow your search - 

Progress notes can be 

viewed by treatment 

status. To make it easier 

to look through the progress notes, turn on only the status button for the type of procedures you are looking for: 

treatment plan, completed, existing, conditions, exams, or referrals.

3. Viewing clinical notes - If what you are looking for would be found in the clinical notes for a procedure, you can either 

switch to the Clinical Notes tab or view the clinical notes within the progress notes by clicking the Clinical Notes 

button. When you view clinical notes within the progress notes, you can sort them by column to make finding what 

you want a little easier. 

4. Painting progress notes - You can have the paint colors assigned in the Graphic Chart correspond to the color of your 

progress notes, which may help you locate them more quickly. To coordinate your progress note color with your paint 

colors, from the Chart menu, select Setup > Chart Display Setup. In the Chart Display Setup dialog box, check Use 

Paint Colors for Progress Notes. Then click OK. 

Try out some of these sorting features in the Progress Notes panel. Many of them can be combined for a more in-depth 

sorting experience (combine the sorting of columns with the selection of certain status buttons, for example). And if you 

need to undo all your column sorting and start all over from scratch, click the Default Sort button, which sets procedure 

notes back to a chronological order with the oldest notes at the top of the list.
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Searching for Payments 

Have you ever had to research an insurance payment that you know you entered into Dentrix, but you don’t know who 

the payment was posted to? Or, have you ever had a patient call you to talk about a payment they made “earlier this year” 

that they have questions about? You can use the Search Payments utility to find specific payments that have been posted 

to the Ledger without having to manually 

look through patient accounts or running 

reports. You can find payments using the 

information you have, such as check number, 

date, insurance carrier, payment type, amount, 

or guarantor. 

To use the Search Payments utility:

1. From the Ledger, click File > Search 

Payments. The Search Payments dialog 

box appears.

2. Enter the search criteria you want to 

use to search for the payment(s). You 

can combine several search criteria for a 

more precise search with fewer results.

3. When you have entered your search 

criteria, click Search. 

Any payments matching your criteria are listed. 

Double-click any payment listed to open the 

Ledger for that patient so you can view the 

payment in more detail.



10 | www.Dentrix.com/Magazine

Assigning Providers to Procedures before Posting Them 

One of the new features in Dentrix G6 is the ability to assign providers to individual procedures in an appointment 

before setting it complete. For example, if you have an appointment with an exam performed by the doctor and X-rays 

and a prophy completed by the hygienist, then you adjust the providers before posting it complete. When you set the 

appointment complete in the Appointment Book, you can assign procedures to different providers, and double-check that 

the correct provider is assigned to each procedure. 

To set procedures complete for an appointment with multiple providers:

1. In the Appointment Book, select the 

appointment you want to set complete.

2. From the toolbar, click the Set Complete 

button. The Set Appointment Procedures 

Complete dialog box appears.

3. By default, the procedures associated 

with the appointment are listed in the 

Select Procedures group box, with a 

check mark in the Post column, and 

assigned to the patient’s appointment 

provider in the Provider column.

4. Uncheck any procedures that were not 

completed during the appointment, if 

needed.

5. To change the provider for a procedure, 

select the procedure in the list and click 

the Change Provider button.

6. Select the appropriate provider for the selected procedure. Click Other to open the Select Provider dialog box from which  

you can select any active provider in the practice, if needed. The provider name changes for the selected procedure. 

7. Click Post/Set Complete. 

The appointment color changes to gray in the Appointment Book and Dentrix posts the procedures to the Ledger. For more 

information about other new features of Dentrix G6, including information on how you can upgrade, visit www.g6.dentrix.com.

 

The Practice Treatment Case Report   

Outstanding treatment plans can be one of the most valuable sources 

of revenue for your practice. It’s important to track how well you are 

doing with case acceptance and to find outstanding treatment so you 

can make sure you are addressing your patients’ health needs and being 

as profitable as possible. The Practice Treatment Case Report shows a 

detailed report of all patients with treatment plans. With this report, you 

can see the total number of accepted and rejected cases. 

To print the Practice Treatment Case Report:

1. In the Treatment Planner, from the File menu, click Print > Practice 

Treatment Case Report. The Practice Treatment Case Report dialog 

box appears.

2. Use the filters within this dialog box to select the range of patients, 

procedure codes, case status, etc. that you want the report to 

include.

3. To save your custom report settings for the next time you run the 

report, check Save as Default.

4. To preview the report before printing, check Print Preview.

5. Click OK to print the report. 

Similarly, you can print a Patient Treatment Case Report to see a detailed 

report of treatment plan cases for a specific patient. First select a patient 

in the Treatment Planner, and from the File menu, click Print > Patient 

Treatment Case Report. Apply filters as needed, and preview or print  

the report.
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Put more of Dentrix 
to work for you.
Ever wonder if you’re doing things the hard way? 
Find out what tools you’re not using at a Dentrix workshop. 

Coming to cities nationwide this fall!

Mastery Tracks professional skills assessment included with these workshops. 
©2015 Henry Schein Inc. A-DTXTRN-DTXMAG-Q315

Gain an in-depth understanding of how to correctly bill 
insurance in order to increase claim acceptance and 
collect more quickly and easily. Includes new G6 Ledger!

Learn to simplify the billing statement process, enhance the 
effectiveness of collections efforts, and properly track and 
manage important A/R routines. Includes new G6 Ledger!

Insurance: Billing 
and Collections
Do it right to get paid faster

Accounts Receivable 
Management
Take control of your patient A/R

1-day class for experienced Dentrix users 
9 am – 5 pm$299 per 

person
1-day class for experienced Dentrix users 
9 am – 5 pm$299 per 

person

6 CE CREDITS 6 CE CREDITS

View course descriptions and register online at www.Dentrix.com/Workshops or call 866.367.2711

when you register at 
least 3 weeks early!$40per seat

OFF
Become familiar with the essential Dentrix features that 
will help you work more effectively in your practice, and 
make your daily routines easier and more efficient.

Essentials 
Workshop
Master the basics

EARLY REGISTRATION SAVINGS!

Earn 6 CE Credits per day
2-day class for newer Dentrix users 
9 am – 5 pm$449 per 

person

12 CE CREDITS

Discover features that make charting easier and more 
efficient. Learn to create thorough, accurate clinical 
records in the Dentrix Patient Chart and Perio module.

Treatment Planning 
and Case Presentation
Create and present treatment options effectively

Clinical 
Charting
Move beyond just posting procedures

Learn in-depth how to create, customize, present and 
manage patient treatment plans for improved patient 
education, case acceptance and documentation.

1-day class for experienced Dentrix users 
9 am – 5 pm$299 per 

person

6 CE CREDITS

1-day class for experienced Dentrix users 
9 am – 5 pm$299 per 

person

6 CE CREDITS
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Senior Product Manager
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MASTER
   THE METRICS

              THAT

 MATTER



T
he best way to be successful is to maximize the productivity and efficiency in your 

practice. How? By understanding and managing the key performance indicators 

(KPIs) in your practice on a regular basis. 

Just like your blood pressure, body weight, and cholesterol numbers indicate your physical 

health, your KPI numbers indicate the financial health of your practice. 

Monitoring your KPIs and taking action to improve them can help you eliminate waste, optimize 

production, improve efficiency, and drive higher profitability. Mastering the metrics that matter 

gives your practice a competitive edge. 

Which KPIs matter most to practice profitability? Henry Schein has researched this question 

extensively. After measuring dental practice success for more than 20 years, we recommend 

dentists focus on these five KPIs: active patients, active patients in hygiene, production, 

accounts receivable, and schedule optimization.

KPI #1:
Active Patients

The Pulse of Your Practice

Your active patients—the number of patients who visited your office in the past 18 months—is 

the #1 KPI because it affects the current and future cash flow of your practice.

Think of your active patients as the pulse of your practice. A steady increase in active patients 

from month to month is a sign of a healthy, growing practice. If your active patient base 

shrinks, overall cash flow will soon shrink as well.

Discover the five key performance indicators 
that reveal the health of your practice. 

MASTER
   THE METRICS

              THAT

 MATTER



Your practice management software can help you track 

your active patients. Once you identify your active patient 

base number, start working to stabilize and increase it.

Set monthly, quarterly and yearly goals to grow your active 

patient base. Involve your team in growing this number by 

encouraging follow-up visits and new patient referrals.

How you enter a patient into your database for the first 

time can help you track the source of your new patients. 

Take the time to enter new patient information accurately, 

including specifying the referral source (Figure 1). Over 

time you can see where your best referrals are coming 

from and nurture those sources.

What to Do
If your number of active patients is declining from month 

to month, it’s time to take action.

To maintain a healthy pavient base, the average practice 

should see between 20 and 25 new patients per month. If 

your active patient base isn’t growing, try this:

• Follow up on patients who are overdue in hygiene.

• Ensure the patients coming in today are set up 
correctly in the scheduling system so their continu-
ing-care future due dates are accurate.

• Track where new patients are coming from and  
focus on the marketing activities that yield the  
greatest results.

KPI #2: 
Active Patients in Hygiene 

Your Primary Growth Source

Your active patients in hygiene—the number of patients 

with a hygiene appointment in the past 12 months—is a 

crucial metric for two reasons: 

1. It forecasts the number of active patients you will 

have over the next 12 months. 

2. It is the primary source of growth and production for 

your practice.

Forecasting your active patients in hygiene lets you know 

if your practice is on track to achieve your financial goals. 

If your active patients in hygiene start to decline, you can 

take corrective measures to bring the numbers up before 

another six months go by.

Ensuring that patients are scheduled to return for their 

hygiene visits every six months also helps maintain and 

increase your active patient base (KPI #1). 

What to Do 

Look at the number of patients seen in hygiene and 

the number of patients who have scheduled return 

appointments in the next six months. If the number of 

hygiene reappointments falls below 85 percent of the 

active patients in hygiene number, it’s time to take  

action. If your hygiene patients aren’t reappointing,  

try this:

• Use the Continuing Care module to track the due 
dates and last visit dates of your hygiene patients. 

• Set up standard routines to encourage and remind 
patients to schedule hygiene appointments before 
their due date.

• Attach continuing care to each patient coming 
through your practice. 

KPI #3 
Production 

A Healthy Hygienist/Doctor Mix

Tracking the production numbers for hygienists and for 

doctors separately lets you know who is doing the work, 

what the work is, and how much revenue your practice 

can expect from each provider.

A healthy mix of hygiene and doctor production is vital 

for practice profitability. An average production mix of 

65–75 percent for doctors and 25–35 percent for hygiene 

is ideal.

The Dentrix Practice Advisor Report can help you 

track production by provider, overall production, case 

acceptance, outstanding treatment plans, reappointment 

rates and other areas that affect practice profitability.

What to Do 
If hygiene production falls to 15–20 percent of your 

total practice production, it’s time to take action. If your 

production numbers are down, try this:

• Discuss production numbers in your daily huddle 
meetings.

• Ask the team for ideas on how each team member 
can improve case acceptance, patient care and overall 
production.

• Help patients overcome financial worries, fear of in-
vasive procedures, and other barriers to treatment by 
openly discussing their concerns.

Figure 1 Entering referral sources in new patient 

appointments helps you identify your best referral sources.

14 | www.Dentrix.com/Magazine
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KPI #4
Accounts Receivable 

Easy to Measure, Hard to Do

The accounts receivable management KPI shows whether 

your practice is actually making money. Profitable practices 

set a goal to collect at least 98 percent of their total 

adjusted production (gross production minus adjustments).

For example, if your monthly gross production (the sum 

of the fees you normally charge patients) is $80,000, 

and your monthly adjustments (discounts and insurance 

write-offs) are $16,000, your total adjusted production is 

$64,000. Your collection goal for that month would be 

$62,720 (98 percent). 

The way you manage your accounts receivable determines 

your profitability. While this may seem obvious, many  

practices fail to compare their outstanding A/R to their 

production each month.

Dentrix can provide valuable insight into accounts 

receivable so you can take the appropriate measures to 

get paid. Monitor the following A/R figures at least once  

a month: 

• Account balance aging (30, 60 and 90 days) 

• Pending insurance claims aging 

• Daily over-the-counter collections 

• Total collections 

• Totals by provider

The sooner you can address a collections issue, the more 

likely you’ll get paid. Outstanding balances beyond 30 

days should be targeted first. Once a balance ages beyond 

90 days, you lose 7 percent of the value of that balance 

every month. By the time the balance ages 12 months, your 

practice has lost more than the balance is worth.

What to Do
If your monthly collections rate is lower than 98% of your 

adjusted production totals or if you have outstanding 

balances that are over 30 days past due, try this:

• Provide third-party financing options to help your 
patients afford necessary treatment.

• Put a written financial policy in place and make sure 
your patients understand it and your team reinforces it.

• Help your patients pay on time by setting up electron-
ic payment plans.

• Flag balances that are more than 60 days overdue and 
call these patients ASAP.

• File insurance claims electronically.

KPI #5
Schedule Optimization 

The Fuller the Better

Schedule optimization is the cornerstone of an efficient 

and profitable practice. Managing your schedule 

effectively can minimize team stress, increase patient 

satisfaction, and maximize production.

Properly setting up your Appointment Book affects 

several key metrics of practice success, including: 

• Average hourly production 

• Production by procedure 

• Unfilled hours 

• Scheduled hours 

• Number of broken appointments not  
reappointed 

• Revenue lost from broken appointments

Unfilled hours in your schedule directly 

affect your bottom line. Losing one hour 

of hygiene time per day over a 210-day 

year can cost your practice more than 

$30,000 in a year. Losing one hour of 

dentist time per month can cost your 

practice more than $144,000 in a year. 

TOTAL PRODUCTION
- ADJUSTMENTS

ADJUSTED
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    X .98 (98%)

        COLLECTIONS GOAL
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What to Do
Unfilled provider time means lost production. Monitor your 

schedule regularly, and when you see that providers have 

open time in the schedule, use the tools in Dentrix find 

patients to schedule. To help fill unscheduled hours, try this:

• Use the ASAP List to find patients who want to come 
in sooner than scheduled.

• Use the Open List to find patients with flexible  
schedules.

• Use the Unscheduled List to track patients who cancel 
or miss appointments and contact them to reschedule 
when you have openings.

• Reach out to patients with postcards, emails, and text 
messages to remind them that they have unscheduled 
treatment plans and encourage them to schedule.

Next Steps 

Implement and Manage KPIs

Analyzing your practice performance based on specific 

numbers gives you a better understanding of your 

practice’s strengths, weaknesses, and opportunities.

In Dentrix, for example, you can run the Practice Advisor 

Report to see your KPIs at a glance. This report shows your 

active patient base, active patients in hygiene, practice 

production, accounts receivable, schedule optimization, 

and many more indicators of your financial health. You can 

also compare your current performance to past months or 

year-to-date numbers.

The Practice Advisor Report compares your practice’s 

KPI statistics to industry-standard benchmarks. When 

your KPIs fall below the benchmarks, the report offers 

recommendations to help you improve your profitability. 

If you want more personalized recommendations specific 

to the problems in your practice, you can also sign up for 

the Dentrix Profitability Coaching program. Whether you’re 

new to Dentrix or you’ve been using the software for years, 

Dentrix Profitability Coaching can help you implement and 

manage KPIs for greater practice efficiency and profits. To 

learn more about Dentrix Profitability coaching, visit www.

Dentrix.com/Coach. 

You’ve worked hard to establish your practice. By mastering 

the metrics that matter you can ensure it remains a healthy, 

growing practice. Make a regular checkup of your KPI “vital 

signs” a method for your success. 

LEARN MORE

To learn more about the Dentrix Practice Advisor Report, 

see the “Practice Advisor Report” topic in the Dentrix Help 

or view article #47688 in the Dentrix Resource Center. 

LIMITED TIME OFFER: Your Dentrix data can tell you a lot about what’s right and wrong about your 

practice. Learning how to use your Dentrix system to measure key performance indicators (KPIs) 

is the first step to increasing your profitability. For a limited time, Dentrix profitability coaches with 

Dentrix and practice management experience will provide you a free assessment of your practice—

using your data—so you can improve performance using the profitability tools built into Dentrix. 

Sign up for your free practice assessment* before this offer ends at www.Dentrix.com/Assessment. 

*Doctor must be present for the assessment.
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DATA CAN TELL YOU 
WHAT’S RIGHT AND 
WRONG IN YOUR 
PRACTICE

IMPROVE YOUR PROFITABILITY
Meet with a Profitability Coach for a free 45-minute assessment. 
See what your data says about your practice’s strengths and 
weaknesses, and key areas to improve to immediately boost profits. 
Act now. Consulting slots are limited and this offer expires Sept. 30.

SCHEDULE YOUR FREE PRACTICE ASSESSMENT NOW AT

DENTRIX.COM/ASSESSMENT

Coaching_DentrixMag_v2.indd   1 7/29/15   5:47 PM

www.dentrix.com/assessment
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MANAGING YOUR CONTACTS IN

Figure 1 The eDex window.

GARY FRAZIER
Contributing Editor

Explore the new Dentrix G6 eDex  
module and find out how to create  
a digital contact directory in Dentrix. 

M anaging and organizing contacts can be  
a daunting task for any business. Over  
time you become acquainted with many 

salespeople, computer technicians, tradespeople, 
employees, specialists, and other professional 
contacts. In the past, you may have relied on a 
Rolodex, an address book, business cards, or 
even sticky notes to keep track of all these 
contacts. Today, you may keep your contacts on 
your cell phone—at least the ones you 
communicate with most frequently. With Dentrix 
G6, you now have an alternative to these other 
organizers, and it can be easily accessed by your 
entire office staff.

eDex is an electronic contact manager and 

directory to which you can attach patient, 

account, and other contact notes. You can use 

eDex to manage and quickly search lists of 

patients (active, inactive, or archived), employers, 

insurance carriers, labs, non-patients, providers, 

staff, referrals, and any other contacts you may 

want to remember. Using eDex, you can create 

custom contacts and contact categories to filter 

the Contacts List or even locate a patient’s next 

appointment. The eDex window consists of the 

eDex and Dentrix modules toolbars, the Search 

text box, the contacts list, and a contact details 

and notes area (Figure 1). 

Adding Contacts and Categories

To open eDex, from the File menu in most Dentrix modules 

click eDex. You can add contacts to eDex and organize them 

by category. By default, eDex adds all new contacts to the My 

Contacts category, but you can add categories as necessary 

to organize your contacts according to the criteria you define. 

You can also set filters so you can search by the categories 

that you have defined.

To add a contact, click the New Contact button on the eDex 

toolbar. From the Add New Contact dialog box, select the 

category that you want to add the contact to, type the 

contact’s information in the appropriate text boxes, and then 

click Save (Figure 2). 
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MANAGING YOUR CONTACTS IN

To edit a patient’s 

contact information, 

click the Family File 

button in the Dentrix 

modules toolbar to 

open the Family File.

By default, eDex 

comes with 13 

categories that you 

can use to organize 

your contacts. You 

can add to these 

categories, and 

you can delete any 

categories that 

you create, but 

you cannot delete 

any of the default 

categories.

For example, to add a category for computer technicians, 

click the Edit Contact Categories button on the eDex 

toolbar. From the Edit Contact Categories dialog box, 

click Add New (Figure 3). Type the description of the 

category, and then click the Select Color square and select 

a color for the category in the Category Setup dialog box. 

Click OK.

Searching For Contacts and Appointments

Before conducting a search of your contacts list, you’ll 

want to set the parameters of your search by setting filters. 

Click the Set Filters button on the eDex toolbar. From the 

Set Filters dialog box, click Clear/Select All, and then from 

the list, select the filters that you want to search by. Click 

Close. You can then search for a contact by simply typing 

the contact’s name, phone number(s), email or home 

addresses in the Search text box of the eDex window.

From eDex, you can open the Appointment Book and locate 

a patient’s next appointment. Or, you can change a future 

appointment’s status directly from eDex by clicking the 

down arrow and selecting the appropriate status from the 

list (Figure 4).

Notes

eDex provides areas for three types of notes. The first is the 

patient note. This is the same patient note found in the Family 

File, and if a patient has a patient note in the Family File, it 

appears in eDex. But, you can also add or append a patient 

note from eDex to the Family File by clicking the Append 

Patient Note button (Figure 5).

The second type of note is an account note. A note only 

appears in the Account Notes text box in eDex when the 

patient has an account note in the Ledger.

The last note type is a custom note which is specific to eDex. 

You can add a custom note to any type of contact in your 

contact list simply by typing in the Custom Notes text box. 

The Custom Notes text box includes a toolbar that you can 

use to format the text. You can also use a note template to 

ensure that your notes are consistent from contact to contact. 

You can even create and edit templates to fit the needs of 

your office.

eDex is a powerful tool from which you can save and organize 

your contacts or open Dentrix modules such as the Family 

File, the Ledger, the Appointment Book, the Patient Chart, 

and the Document Center.  

Figure 2 The Add New Contact dialog box. Figure 4 Changing an appointment’s status from the 

eDex window.

Figure 5 The Append Patient Note dialog box.

Figure 3 The Edit Contact 

Categories dialog box.
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Create more accurate clinical records with 
the visual tools in the Dentrix Patient Chart. 

When you are traveling down the path to a 
paperless office, the computer is your patient 
chart, and your clinical documentation is all 

stored electronically. You no longer have your blue and red 
indelible pencils to draw in the existing fillings, put Xs on 
the missing teeth, and mark up the tooth chart the way 
you want it. The goal with an electronic chart, as with a 
traditional paper chart, is to make it as accurate as possible 
so that as the doctor walks in for the exam or discusses 
the treatment plan, mistakes aren’t made based on 
inaccurate information.

This article teaches some of the tips and tricks you can  

do with Dentrix to make the patient chart look as accurate 

as possible.

A Few Charting Tips

Remember when you were treatment planning that occlusal 

pit composite filling or the MOD that covered the entire 

mesial cusp, and you could get out your colored pencils 

and color away? You can do the same thing in the Dentrix 

Patient Chart. As you treatment plan the procedure, from 

the Select Surface dialog box, just click the Cusps/Pits 

button to expand the dialog box (Figure 1), select the paint 

surfaces you want, and click OK. If the filling has already 

been treatment planned and you want to change the look 

of the filling, right-click the tooth in the Patient Chart, and 

then click Edit Surface Painting in the shortcut menu. In 

the Edit Surface Painting dialog box (Figure 2), make the 

needed changes, and click OK.

Remember in the 

paper chart you could 

pick up your pencil 

and draw in a lingual 

bar retainer or circle 

something you wanted 

to remember? With the 

Chart Notations, you can 

do exactly that. On the 

Chart module tool bar, 

click the Chart Notations 

icon (Figure 3) and then 

click Edit Notations. The 

Dentrix Notations palette 

appears (Figure 4). 

Select the color and size 

of pen you want, such 

as a Fine Point Pen. Use 

your mouse to freehand 

draw on the tooth in the 

Patient Chart. If you want 

to erase your drawings, 

select the eraser tool.

What about the patient who had 4-bi extractions during 

ortho when they were a teenager? You don’t want it to look 

like they have missing teeth. What about the patient who 

has a large diastema between 8 and 9? Using Conditions 

in the Procedure Codes palette (Figure 5), you can create 

a visual picture of the patient’s mouth. Here are some 

common conditions to use:

• 15000 Mesial Drifting: Use 
this for missing teeth when 
the space has been closed. 
This paint type will put ar-
rows to show the space has 
been closed.
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A Patient Charting Primer

Figure 1 The Select Surface dialog box.

Figure 2 The Edit Surface Painting 

dialog box.

Figure 3 The Chart Notations icon on the Chart module toolbar.

Figure 4 The Dentrix 

Notations palette.
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DAYNA JOHNSON
Certified Dentrix Trainer

• 15112/15113 Mesial/Distal Open Contact: Use this for diastemas  
and open space between teeth.

• 15114 Unerupted: Use this condition when the tooth is below the 
gum line. (Using this condition will also cause the Perio Chart to  
skip the tooth.)

As you explore the features and capabilities of the Dentrix Patient Chart, 

you’ll discover how easy it is to create and maintain accurate charts as 

you continue down the path towards a paperless office.  

LEARN MORE

To learn more about the Dentrix Patient Chart, see the “Patient Chart 

overview” topic in the Dentrix Help.

Dayna Johnson, founder and principal consultant of Rae Dental 

Management, helps dental offices improve patient care, increase 

collections, and reduce staff headaches by implementing efficient 

management systems. With 20 years of experience in the business and 

technical side of dental offices, Dayna’s passion for efficient systems is 

grounded in both personal understanding and professional expertise. 

Dayna can be reached at dayna@raedentalmanagement.com or visit her 

website at www.raedentalmanagement.com.

 

Figure 5 Conditions in the Procedure 

Codes palette.

“DDX makes my scanner even better!
My case turnaround time has been cut in half and I 

can now store my cases in the cloud freeing up valuable 

office storage space. With the full integration of my lab 

case work into the Dentrix patient record I see everything 

in one place.  Thank you DDX and Dentrix”.

- Dr. Bill Busch, DMD MAGD
  Kansas City, MO

REDUCE YOUR CASE
TURNAROUND BY 50% OR MORE!

 

Schedule your demo today!
www.ddxdental.com or call 877-244-9345

Increase the efficiency of your digital scanner with DDX ®

®·       Fully integrates with Dentrix 

 ·     Streamline your in-office lab work

·      Save time and eliminate costly 
       scheduling errors
 
·      DDX is FREE to dentists and only 
       takes a few minutes to set up 
          

DIGITAL DENTAL EXCHANGE
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Increase efficiency and become more 
profitable with these 14 tips. 

Do you ever feel like there aren’t enough hours in  
the day? Are your expenses increasing, but your 
profit isn’t? Are you disappointed in your expected 

return on investment of equipment purchases?  

A common thread among practices with these chall-

enges is lack of efficiency. Efficient doctors and teams 

complete tasks in the least amount of time possible with 

the least amount of resources possible by utilizing time-

saving strategies. Inefficient doctors and teams take the 

long road.

Skip the long road! In fact, if you are not looking at ways 

to become more efficient in your practice, you may well be 

losing ground on staying profitable and successful. 

Successful companies look at ways to enhance 

efficiencies. There’s the “olive” of change that American 

Airlines made in the 1980s. They calculated that if 

you remove just one olive from every salad served to 

passengers, nobody would notice and the airline would 

save $40,000 a year.

At the American Standard plant in Tyler, Texas, it’s the 

doormats in the entryways. Now, they just get vacuumed 

instead of sent out for cleaning and that saves the company 

$70,000 a year.

Xerox saved $200,000 a year by having the employees do 

the watering instead of a watering service.

As a small business, efficiency is even more important 

because your resources are limited compared to large global 

companies. To keep pace in an increasingly competitive 

world, your practice needs to run as efficiently as possible. 

Efficiency isn’t just about reducing costs; you still have to 

achieve other business objectives, including service quality, 

in order to attract new patients, keep existing patients, and 

provide profitability. The blending of efficiency and service 

quality is the combination you need to maintain a healthy 

practice in a competitive economy.
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Efficiency Equals Profitability

To keep pace in an increasingly 

competitive world, your practice  

needs to run as efficiently as possible. 
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Take action! Schedule a meeting with the doctor(s) and the 

entire team to look at ways you can enhance efficiencies while 

also providing great service.

Here’s a jump start checklist you can use to increase the 

efficiency in your practice today!

1. Set the operatory up right the first time. Barring a 

change in the procedure, the dental assistant should not 

need to get up and down and break the flow  

of treatment.

2. Inventory is money on the shelf. Establish a monthly budget 

for dental supplies and stick to it! Keep it to within 5-7% of 

total office production (this does not include equipment 

purchases or single items over $500). Avoid over-stocking.

3. Evaluate overtime expense. If this occurs on a regular 

basis, why is that? The goal is everyone is clocked out no 

later than 30 minutes after the last patient leaves.

4. Are you paying for services you no longer use? Investigate 

all auto charges/deducts and invoices to assure that you 

still are using the service.

5. Meet with your insurance advisor to make sure your 

current policies are adequate for today’s needs. If you are 

leasing or paying on a loan on equipment, check that you 

are sending your Lender’s Loss Payable Endorsements to 

avoid unnecessary charges. 

6. Assess the need for every hygiene patient to receive 

a toothbrush, floss, etc. Those patients with electronic 

toothbrushes may not want a brush. Customize to the 

patient’s need. They may not even miss a full goody bag 

and you’ll be able to save an “olive.”

7. Check the settings for your HVAC system. Does the heat/

air need to be on during non-business hours? Schedule 

regular maintenance to keep your system running at its 

most efficient and effective level.

8. Invest in marketing that gives a Return On Investment 

(ROI). Track each marketing investment to make sure it is 

providing the desired results.

9. Make sure patients are always scheduled for their next 

appointment BEFORE they leave today’s appointment. 

The goal is that 95% of your patients leave with a next 

appointment scheduled. At a minimum, everyone needs 

a next hygiene appointment. Even your fully edentulous 

patients need to be seen annually!

10. Minimize your cancellation risk through effective 

communication skills that help keep the patient scheduled. 

11. Do not be the bank! Partner with a third-party finance 

company to be able to answer patients with, “Yes, you 

can make payments!” This provides a huge savings 

in employee time following up with patients on their 

payment plans.

12. Avoid over-staffing. Engage with an electronic patient 

confirmation service like the eCentral Communication 

Manager that can work behind the scenes confirming 

appointments, sending marketing messages, offering a 

portal for patient payments, etc.

13. Save your stomach lining and money. Have a current 

personnel manual that spells out all HR requirements. 

When a question comes up, refer to it and use it to 

answer employee questions.

14. Significantly increase your ROI on a piece of equipment 

you may already have: your intra-oral camera. Use it 

for every new patient exam and in hygiene. Remember, 

a picture is worth a thousand words and will build 

enormous trust with your patients.

Remember, this is not an exercise in cost-cutting. Instead, 

efficiency is a measure of whether the correct amount of 

resources have been used to deliver a process, service, or 

activity. An efficient process achieves its objectives with the 

minimum amount of time, money, people, or other resources.

Start today by enhancing the efficiencies in your office and be 

prepared to see greater profitability that provides for continued 

growth and stability in your practice.  

Bringing greater productivity and profitability to general dental 

and periodontal practices has been the result of Virginia Moore’s 

consulting practice over the past 25 years.

As a speaker, Virginia has presented at the top dental meetings 

in the U.S. and has spoken at meetings in Canada, the Middle 

East and Asia.

Virginia is a contributor to ADA’s newest publication Expert 

Business Strategies, is a regular contributor to ADA’s Dental 

Practice Success, as well as authoring two books and co-au-

thoring eight books on practice management. Her passion is 

getting results that further the success of dental practices.

Virginia is a graduate of the ADA KEMP for dentists. She is a 

member and past president of the Academy of Dental Manage-

ment Consultants and also holds membership in the National 

Speaker’s Association and the Speaking and Consulting Network.

She can be reached at vmoore@virginiamoore.com or  

530-527-9457.

VIRGINIA MOORE 
Moore Practice Success

Efficient doctors and teams complete tasks in the least amount of 

time possible with the least amount of resources possible.
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Are you at risk for a data breach? 
Conducting a security risk assessment  
is the first step to finding out.

The terms data loss and data breach are enough to send 
chills down the collective spine of any dental practice. 
And with good reason. The legal fees, remediation costs, 

restitution, fines, and negative media exposure can be hard to 
recover from and can have a lasting impact on your practice. In 
short, not only do you need to protect your bottom line, but 
also the privacy of your patients and your reputation.  

The serious risk associated with a data loss or breach is 

exactly why conducting an annual Security Risk Assessment 

(SRA) is now a core HIPAA requirement. A properly 

conducted SRA is the first step in identifying potential 

information security risks which you can then address by 

implementing solutions to improve your practice and keep it 

HIPAA compliant. 

Generally speaking, an effective SRA provides a large scope 

analysis that evaluates data collection and storage, potential 

threats and vulnerabilities, and current security measures. It 

considers the “criticality,” or impact, of potential risks to the 

confidentiality, integrity, and availability of PHI. Through the 

SRA you must assess the magnitude of the potential impact 

resulting from a threat triggering or exploiting a specific 

vulnerability. You may be required to perform additional 

assessments, depending on the structure of your practice. 

You’ll also be required to provide an organized report that 

reviews the findings of the assessment.

For example, you would need to examine and document the 

following areas of your practice as part of an SRA:

• Review of protected health information (PHI)  
inventory to determine where electronic and other 
data are located

• Examination of the three security safeguards:  
administrative, physical and technical

• Examination of the practice according to the latest 
Omnibus rules

• Assessment of current operations for HIPAA compli-
ance, including safeguards in place, as well as vulnera-
bilities and specific threats to safeguards

• Evaluation of existing security policies and procedures 

You can perform your own SRA using a tool provided by the 

Department of Health and Human Services1. However, many 

practices are choosing to hire a third party to conduct their 

SRA because they find the process complicated and time-

consuming. Others are worried about making mistakes or 

not knowing the best path to remediation. Since your time 

is better spent doing what you do best—focusing on your 

patients—let TechCentral’s partner ClearDATA help you avoid 

the stress by conducting your SRA for you. 

ClearDATA has conducted thousands of successful 

assessments. Known for being affordable, quick, effective 

and comprehensive, ClearDATA prides itself on going 

above and beyond the basic SRA requirements. For 

example, many assessment providers overlook examining 

the three safeguards required by 45 CFR 164.308 (a)(1)—

administrative, physical and technical, including the latest 

Omnibus rules—which ClearDATA considers essential to 

the evaluation. ClearDATA’s post-assessment report is also 

incredibly comprehensive; it includes detailed vulnerabilities 

and remediation recommendations and is audit-ready. By 

using the Common Security Framework and complying with 

Health Information Trust Alliance (HITRUST) standards, you 

can be certain that your SRA assessment through ClearDATA 

will be comprehensive and top of the line.

Learn more about how an SRA through ClearDATA can 

protect, and even improve, your practice. For more 

information about security risk assessments, contact 

TechCentral at 877-483-0382 or visit us on the web at  

www.HSTechCentral.com.  

LEARN MORE
Learn more about the types of security policies and proce-

dures you can implement by reading the Dentrix eNewsletter 

article “4 Tips for Addressing Security Threats in Your 

Practice” (http://dentrix.com/articles/content/id/1603).
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Protect Data with a Security  
Risk Assessment

THOMAS GROVER 
TechCentral Marketing Manager

1 You can download an SRA tool to help guide you through the risk assessment 
process at http://www.healthit.gov/providers-professionals/security-risk-assess-
ment-tool. Note that the tool is provided for informational purposes only and is 
neither required by nor guarantees compliance with federal, state or local laws.
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• Detailed patient and family profiles appear as the phone rings, so you can book more 

appointments at once

• Improve your patient’s experience by providing more personalized and efficient service

• Settle accounts on the spot with pop-up notifications of overdue balances

• Promote treatment specials and promotions with customized on-hold greetings

• Utilize the click-to-call feature right from the patient’s profile to save time and boost 

productivity

• Reduce the duration of routine calls with automatic note saving integration

HAVE ALL THE ANSWERS BEFORE YOU ANSWER 

Broadview Networks’ 
OfficeSuite Dental™ is the 
only personalized patient 

dashboard and phone  
system that fully integrates

with Dentrix G5®

Create a More Profitable, Productive Practice with OfficeSuite Dental™

Please visit us at www.HSTechCentral.com/HaveAlltheAnswers
or call us at 877.483.0382 to learn more about OfficeSuite Dental™.
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ImageRamp and Dentrix:  
Easily Scan to the Dentrix Document Center 

 David Wilson | CEO and Founder, DocuFi, Inc.

Learn how ImageRamp™ for Dentrix simplifies scan and file capture and integrates your records and notes 
with Dentrix. 

SOLUTION 
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Protected Trust and Dentrix:   
One-step, Stress-free, HIPAA-compliant Email 

 David Bailey | VP Protected Trust

Share X-rays and protected health information with associates and patients using HIPAA-compliant email 
software from Protected Trust.

Email security has been a major topic of discussion in the 
medical community for many years. Health care 
providers have seen a host of protected health 

information (PHI) exposed due to employee errors, 
unencrypted email messages, and other issues. Although news 
regarding major breaches has been mostly related to hospitals 
and insurance providers, this does not mean that dental 
practices are immune from similar breaches.  

Today more than ever, dental practices are sharing PHI and 

X-rays with referring practices, labs, and patients through digital 

environments. In response to the growing need for secure 

transfer of PHI, Protected Trust developed an effective file 

sharing solution. In developing our solution, we made simplicity 

a high priority because we know how important ease of use is 

when considering both productivity and security. 

Protected Trust is simple for the sender to use, and recipients 

can access the encrypted email at no additional cost and 

without the hassle of registration. There is no need to completely 

overhaul the email accounts used in the past. Our HIPAA-

compliant email solutions integrate with Dentrix, meaning 

your private data remains secure within the Dentrix practice 

management software without you having to worry about the 

overhead of managing duplicate data in a third-party product. 

Let’s explore some of the ways Protected Trust can help  

dental practices. 

intuitive, Compliant, Secure

Our secure email services allow you to collaborate with 

confidence, quickly authenticating a recipient’s ID through 

phone or secret message. You also receive a guaranteed 

read receipt upon its opening (Figure 1). Protected Trust also 

supports attachments up to 5 GB, which are also sent via 

the secure connection. In short, security is certainly the main 

objective of Protected Trust’s products and services, but it is  

not the only one. 

We also made sure to incorporate custom-

izable options that allow dental practices 

to control policies and passwords, and 

update email notifications to your liking. 

Here are some of the other benefits you 

can expect:

• Intuitive - Users enjoy a very simple  
experience with our tools, which offer  
a combination of efficiency and pro-
ductivity. 

• Single sign-on - Dental practices can  
use existing network access controls, 
such as logins and passwords, for secure 
email access. 

SOLUTION SPOTLIGHT

Figure 1 The Proof of Delivery Log.
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• HIPAA compliance - Our privacy and security special-
ists take care of the technology so your dental practice
can focus on what matters most: caring for patients. We
comply with government regulations ranging from HIPAA
and HITECH to SOC 2 and beyond, while signing business
associates agreements to really offer peace of mind.

• Mobile - You can send your Protected Trust secured emails
using popular smartphones and tablets, as well as access
your inbox and send folders directly through the native
mail app.

These features and capabilities address several important 

obstacles in modern dental practice management such as 

usability and protection. Perhaps most importantly, since 

dental practices can be fined hundreds of thousands of dollars 

for not complying with HIPAA, and the cost of breach can be 

even higher, we make sure your records are safe throughout 

their life cycles. 

One successful partnership with Agnini Family Dental showed 

just how much of an improvement can be enjoyed by deploying 

Protected Trust solutions in their practice environment. 

Following the implementation, Agnini enjoyed the ease of use 

associated with our software that provides instant compliance 

and the ability for employees to send secure email directly from 

Dentrix. Melissa  Sheffield, Clinical Manager at Agnini Family 

Dentistry stated, “The best thing about Protected Trust is that 

we feel secure in all of our electronic communications and 

confident that we don’t have to worry about compliances.” 

Protected Trust integrates with Dentrix

Our product is a certified Dentrix G5 Connected solution, ready 

to integrate directly into your Dentrix system after purchase. 

Once you choose to email patient data and X-rays to a colleague 

from within Dentrix, Protected Trust takes it from there. Patient 

data is completely and automatically encrypted through a 

secure data tunnel during delivery, and requires the receiving 

party to verify their identity prior to opening, releasing, and 

sharing using security settings that you configure (Figure 2). 

The sender and recipient don’t need to do anything extra other 

than click the Send Message email button on the Dentrix toolbar 

to begin an email message to the selected patient (Figure 3). 

The integration with Dentrix assures that the entire procedure is 

secure and can be executed easily without any additional steps 

or requirements. Simply put, dental practices that use Dentrix 

will enjoy an extremely quick and easy deployment, as well as 

continued efficiency and security 

gains throughout their experiences 

with Protected Trust. 

At the end of the day, centralization 

is an important matter for dental 

practices in this new era of 

technology-based management. 

Our Protected Trust solution, which 

you can access and use easily within 

Dentrix, can boost your efficiency, 

productivity, and security all in 

one fell swoop. What’s more, we’re 

available through Henry Schein’s 

Dentrix marketplace, which makes 

it easy for you to find and purchase. 

You can also sign up for a free, no-

nonsense trial of our encryption  

and HIPAA-compliant email services 

for 15 days! Just give us a call at 

863-594-1141 or visit our website

www.protectedtrust.com.

Figure 3 Sending secure email from within Dentrix using Protected Trust is easy.

Figure 2 The Send Protected Message dialog box.

The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their 
company, products and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions and 
consumers should contact these providers directly if seeking additional information about their products or services.
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You already depend on Dentrix to make your practice more profitable and productive. Now, you can turn 

Dentrix G5 into an even more powerful solution by adding trusted, fully integrated third-party applications 

and capabilities to your digital dental office. The Dentrix Connected logo means the product has been 

carefully developed, tested and certified to work with your Dentrix G5 platform. To see the full list of 

Dentrix G5 Connected applications visit www.Dentrix.com/Integrated-products today.

SOLUTION GUIDE

Broadview
www.broadviewnet.com

Network-based Business 
Communication
Make your practice more profitable with 
OfficeSuite Dental, the state-of-the-art 
phone system that fully integrates with 
Dentrix G5.

BiteBank Media
www.bitebankmedia.com

Dental Practice Solutions
Streamline your practice with custom 
dental websites, appointment 
notification and scheduling, real-time 
booking, patient education videos and 
reputation management.

Citi
www.healthcard.citicards.com

Citi Health Card
One click. One Solution. Patient 
financing just got a lot easier. The Citi 
Health Card program is now integrated 
within Dentrix G5. Spend more time on 
patient care and less money on your 
patient financing program costs. 

Demandforce
www.demandforce.com

Patient Communication Solution
Demandforce works seamlessly with 
Dentrix G5 software to automate 
online and offline communications with 
existing patients to improve in-office 
efficiencies. 

Dental Symphony
www.dentalsymphony.com 

Dental Practice Solution
Dental Symphony’s web-based 
clinical software revolutionizes patient 
management. Working alongside 
Dentrix, Dental Symphony provides 
innovative tools to practice easier,  
safer and more efficiently. 

Apteryx
www.apteryx.com 

Dental Practice Solution
Apteryx exceeds the expectations of its 
customers by creating timely, innovative 
and cost effective software solutions 
that improve the profitability of the 
clients’ businesses. 
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DentalWriter
www.dentalwriter.com

Medical Billing Software
For over 25 years, Nierman Practice 
Management has led medical billing in 
dentistry by continuously developing 
innovative products and providing 
exceptional training for dentists looking 
to grow their practice.

DEXIS
www.dexis.com

Digital Diagnostic Imaging 
DEXIS delivers innovative, high-quality 
digital imaging solutions to the dental 
community. With its state-of-the art  
sensor and easy-to-use imaging 
software, Dexis provides numerous 
benefits to you, your practice, and your 
patients. 

eDossea
www.edossea.com 

Intra-Office Communication
We are solely focused on the dental 
profession and within the dental 
profession on the secure, easy and 
inexpensive transfer of your client’s 
medical records from one office to 
another. This is all we do. 

Great Minds
www.greatminds.com

Dental Practice Solution
Great Minds, Inc. provides easy-to- 
use applications that provide valued 
features and allow efficient and high- 
margin management of the office 
and practice. 

Panda Perio
www.pandaperio.com

Periodontal Practice Solution 
The complete clinical digital record 
for Periodontal practices. Charting, 
comparison reporting,  treatment 
planning, automated chart notes, and 
much more.  Save hours of admin time 
and unify your front and back office. 

Lighthouse
www.lh360.com 

Patient Communication Solution
Lighthouse 360 is a comprehensive 
automated patient communications 
system designed exclusively for dentists. 
It uses email, two-way text messaging, 
automated phone calls, postcards and 
letters to reach your patients. 

Patient Activator
www.patientactivator.com 

Patient Communication Solution
Patient Activator, part of Los Angeles-
based 1-800-DENTIST®, is the leading 
social media optimization and patient 
communications service dedicated to 
the dental profession. 

Practice Mojo
www.practicemojo.com 

Patient Communication Solution
PracticeMojo creates proven campaigns 
that help dental practices recruit, retain 
and reactivate patients automatically, 
using email, text messages, automated 
phone calls and mailed postcards.

Practice Safeguard
www.practicesafeguard.com 

Web-Based Fraud Monitoring
A web-based financial monitoring tool for 
Dentrix G5 users that deters fraud and 
costly errors by alerting any device you 
carry to unusual transactions in real time.
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Transparent Aluminum
www.transparentaluminumllc.com

Dental Practice Solution
Transparent Aluminum is a company 
focused on creating custom workable 
solutions for practices to get the most 
out of their Dentrix database. 

Reputation
www.reputation.com 

Patient Communication Solution
Reputation.com’s platform enables 
dentists to see all their online reviews 
in one space and use the platform’s 
analytical tools to understand the 
broad themes that emerge from 
patient feedback. 

Yapi
www.yapicentral.com

Dental Practice Solution
Started as the first fully integrated 
intra-office communication software, 
YAPI has grown into a comprehensive 
suite of innovative automation solutions 
designed around unique needs of 
dental practices. 

YAPI

U.S. Health Record
www.teamlinks.com

Intra-Office Communication
Teamlinks EHR was created to foster 
interdisciplinary collaboration on 
patient health information with the goal 
of connecting the health care team and 
the patient. 

TeleVox
www.televox.com

Patient Communication Solution
TeleVox Software is a high-tech 
engagement communications company, 
providing automated voice, email, text 
and web solutions that activate positive 
patient behaviors through the delivery 
of a human touch. 

RecordLinc
www.recordlinc.com 

Patient Communication Solution
RecordLinc is the largest professional 
network of dental professionals in 
the world. Securely and easily send 
electronic referrals, patient transfers, and 
track treatment plans between dental 
practices in a HIPAA-compliant portal. 

Text2Floss
www.text2floss.com 

Patient Education
An interactive educational tool meant 
to help patients develop positive oral 
hygiene habits by delivering oral health 
information through the use of text 
messaging and mobile technology. 

Sesame
www.sesamecommunications.com 

Patient Communication Solution
Sesame Communications helps dental 
and orthodontic practices harness the 
power of the Internet to accelerate new 
patient acquisition, build patient loyalty 
and transform the patient experience. 

Solutionreach
www.solutionreach.com

Patient Communication Solution
Smile Reminder provides patient 
engagement and communication 
solutions for healthcare practices. 
Utilizing the latest text, email, voice, 
video, web, and social media tools to 
communicate with customers.

The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their company, products 
and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions and consumers should contact these 
providers directly if seeking additional information about their products or services.
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DDP ad

Take a look at what you can do with Dentrix G6 with testimonials and new feature demo 
videos. You’ll see why your team will want to start using Dentrix G6 as soon as possible.  

Visit  Dentrix.com/G6 to request your copy today.

is here

www.dentrix.com/G6


YOU
ARE
HERE.

TAKE YOUR 
PRACTICE TO  
A NEW LEVEL.

Dentrix Suites are support and eServices bundled 
together for a suite deal. As a Dentrix user with a 

customer service plan, you’re  already on your way 
with the Dentrix Essentials Suite. Now it’s time to 

take your practice to the next level by upgrading 
to Momentum or Optimum. Dentrix Suites lower 

your costs and give you the practice management 
system you need to streamline workflow, build 

patient loyalty and boost your bottom line.     

Dentrix.com/Suites

Dentrix Optimum Suite

Dentrix Momentum Suite

Dentrix Essentials Suite

SuitesDentrixMagAd.indd   1 1/13/15   2:40 PM

Henry Schein Practice Solutions
1220 South 630 East, Suite 100
American Fork, Utah 84003

www.dentrix.com/suites



